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O&O UnErase V2.0 

Simple Restoration of Deleted Files 
These days the mistaken deletion of files is by far the most common 
cause for data loss. Making mistakes is human and often quite 
unavoidable. In the event that the unthinkable occurs, advice can be very 
expensive. Windows tries to avoid this problem with the Recycle Bin 
function – a sort of "Clipboard" for deleted files. When the Recycle Bin 
is emptied these files disappear leaving the user with the assumption that 
these files are now forever lost. But what happens when the Recycle Bin 
is emptied and with it a few precious files were deleted? Is there still 
hope to recover those deleted files and/or folders? 

With the release of the new version 2, we are presenting an entirely new 
user interface, bringing with it an entirely new way to look at the 
restoration of deleted files. With its Explorer-like file structure you can 
navigate through your deleted files just as if they had never been deleted. 
With one click of the mouse you can restore single files or entire folders. 
Never before was the restoration of deleted files so easy and intuitive to 
operate. Whether it be those accidentally deleted text documents or those 
great photos from you last vacation, O&O UnErase V2 can restore all 
data stored on drives recognized and monitored by Windows. With the 
detailed search function you are able to tailor your search to a specific 
set of parameters that can increase the speed and precision of your 
results. And with the completely overhauled algorithm for the restoration 
of data, now even more deleted files on your system can be found. 

In order to increase the chances of success in restoring deleted files, just 
a tip: When you realize data has been deleted, stop all activity on the 
computer and immediately start O&O UnErase to restore the missing 
data. Sometimes, when too much time has elapsed since deletion, 
deleted file can be overwritten when other data are saved to the disk. 
This can hinder any chance at a successful restoration. This is why is it 
advised that O&O UnErase be installed long before any data loss occurs 
to allow for the quick and easy response to an apparent problem. 

We hope you enjoy using our product and hope that it will save you time 
and energy both at work and at home. 

Your O&O Software 
http://www.oo-software.com/    
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New in Version 2.0 

• Support of FAT, FAT32, NTFS and NTFS5 file systems 

• Support of most hard disk drives, floppy drives, USB-Sticks, 
digital cameras, and all other data storage devices supported by 
Windows* 

• Simple and intuitive user interface similar to that of the 
Windows Explorer 

• New and improved search algorithm designed to maximize the 
success of file restoration 

• Restoration of files and folders 

• Advances search feature for more precise searches for deleted 
files 

• Exact customization of search parameters (file size, date 
created/last date modified, file attributes, etc.) 

• Restoration of deleted files and folders with Drag-and-Drop 
functionality onto any drive on the system (including network 
drives) 

• Display and highlighting of deleted files alongside existing files 

• Display and highlighting of deleted folders alongside existing 
folders 

* All data storage devices must be installed in Windows in order to be 
recognized by O&O UnErase. 

Note on Licensing 
You can try out O&O UnErase V2.0 free of charge and obligation. The 
test version of the software allows you search for deleted files but does 
not allow their restoration. Only in the full version is the restoration of 
deleted files possible 

O&O UnErase is licensed per computer. This means that a single license 
is required for every computer on which O&O UnErase is installed. One 
license cannot be transferred to an additional computer.  

If you would like to use O&O UnErase in your company or as a 
technician for your customers, please contact either one of our 
authorized dealers or our sales department for special licensing options. 
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Important Information Regarding the 
Restoration of Data 

Technical Limitations of Data Restoration Software 
O&O UnErase is software designed to restore deleted data. Please note, 
however, that it may not be possible to restore all deleted data. If the 
areas where the deleted data is stored (including the directory table) has 
already overwritten by new data. When this occurs, the restoration of 
data with O&O UnErase is not possible. 

Please do not delete any data for fun or for test purposes without first 
making a back up copy. We strongly recommend that you regularly 
make back up copies of your important data and store them in a safe 
place. 

What should I do when data accidentally gets 
deleted? 
When data are mistakenly deleted on you computer it is very important 
to do the following to maximize you chances of a successful data 
restoration. Should you have further questions, you can always contact 
our technical support department. Please note that we can only provide 
this support for registered users of the software according to their 
individual license agreements. However, in conjunction with our 
subsidiary O&O Services GmbH, our support staff would be more than 
happy to offer you fee-based assistance in rescuing your lost data. 

The correct behavior when faced with the loss of important data can 
contribute greatly to your chances of a successful data restoration. It is 
important to understand that when data are deleted, they are simply 
reclassified on the hard disk or memory card as "free". This allows the 
computer to overwrite and therefore destroy those deleted data. Once a 
piece of data has been overwritten, it is no longer restorable through 
basic data rescue methods.  
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How to Increase the Chances of a Successful 
Restoration of Data? 

• If possible, do not save anymore data onto the system after the 
data in question have been deleted. 

• Close all applications without saving any data to the disk or 
other data storage media (if possible). 

• Shut down the computer. 

• Think calmly about how the data were deleted. Try not to panic 
and quickly restore the data in question. Reckless behavior can 
lead to even more data loss. 

• If the data was deleted "normally", they can be found in the 
Recycle Bin. Open the Recycle Bin and restore the files. 

• If the data were really deleted then it is advised to use O&O 
UnErase to restore them. Load and install the software onto 
another partition of the hard disk (e.g. "D:\" instead of "C:\"). In 
other words, on a section of the hard drive where the data in 
question are NOT stored. 

• If you only have one partition (such as "C:\") it is advised that 
you download and install the software onto another computer. 
Then create a emergency disk with "O&O InstantUnErase" on 
it. More details regarding this function can be found in the 
section entitled "Starting O&O UnErase Without Installing It". 
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Quick Introduction 

If the data has been already deleted… 
1. Install O&O UnErase onto a different computer than the one on 

which you would like to restore the data in question. 

2. Create an emergency disk complete with the O&O 
InstantUnErase Assistant. 

3. Start O&O InstantUnErase on the computer on which the data 
in question were deleted. 

4. Follow the directions as described in the section entitled "Using 
O&O UnErase in Case of Emergency". 

Further information regarding these issues can be found in the following 
chapters: 

• Installation 

• Starting O&O UnErase Without Installing It  

• Using O&O UnErase in Case of Emergency 

Preparing O&O UnErase in Case of Emergency 
1. Install O&O UnErase onto the computer on which you would 

like to restore data should an emergency arise. 

2. Register O&O UnErase with the purchased license code. 
Without a valid license code it will not be possible to restore 
data with the software. 

3. All necessary preparations are now complete. If an emergency 
does indeed occur, you now have a better chance of restoring 
lost data. To do so, please follow the instructions described in 
the section entitled "Using O&O UnErase in Case of 
Emergency ". 

Further information regarding these issues can be found in the following 
chapters: 

• Installation 

• Using O&O UnErase in Case of Emergency 
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Using O&O UnErase in Case of Emergency 
1. Start O&O UnErase from the Start Menu. By default a shortcut 

to the software will be installed in its own folder O&O 
UnErase in the program group O&O Software. Click on O&O 
UnErase to open the program. 

2. After O&O UnErase has been started, select the drive on which 
you would like to rescue your data. In the main view, click on 
the drive to select it. 

3. From the File menu select the command Search for deleted 
files. 

4. If the deleted file could be found, it will appear in the file list to 
the right and be marked with a red "x". 

5. Select the file and select the option Restore from the File menu. 

6. Select a target directory that is not on the same drive. 

7. As soon as the restoration of the file is completed, the file can 
be found in the target directory and opened. 

Further information regarding these issues can be found in the following 
chapters: 

• Installation 

• Using O&O UnErase 
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Installation and System Requirements 

System Requirements  
O&O UnErase V2.0 is compatible with the following:  

• Windows XP (all versions) 

• Windows 2003 Server (all versions) 

• Windows 2000 (all versions) 

• Windows NT 4 (all versions with at least Service Pack 6 and 
Microsoft Internet Explorer Version 5.01 and above installed) 

Required Permissions 

In order to install and register O&O UnErase, you must be a member of 
the local group administrators or possess equivalent permissions. If you 
are a domain administrator, you should have the permissions required as 
well. 

Installation of O&O UnErase V2.0 

The installation of O&O UnErase is very simple. Please follow the steps 
below: 

1. Start the computer on which you wish to install O&O UnErase. 

2. Sign-in as a local administrator. 

3. Open O&O UnErase's installation file (SETUP.EXE) that you 
either downloaded from our web server or have stored on the 
software's CD-ROM. 

4. After the setup program has been successfully initialized, please 
follow the on-screen dialog to complete the installation process. 

5. During the installation process you will be able to select who is 
granted access to O&O UnErase; only the current user or all 
users. 

Installing the Update from O&O UnErase V1.0 to V2.0 
Updating from the old version of O&O UnErase to the newest V2.0 is 
simple and fast. 
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Microsoft Software Installer 2.0 or higher 

1. Start the setup program for the update. 

2. A dialog box will appear in which you will be given the choice 
to Change, Repair, or Remove the program. 

3. Select Repair and click on Next. 

4. The new version of O&O UnErase will then be installed. All 
previous settings will be carried over into the new version.  

Microsoft Software Installer 1.0 

1. Open the Control Panel by going to the Start Menu heading 
Settings. 

2. Click on Add/Remove Programs. 

3. Select O&O UnErase from the list of installed software. 

4. Click on Add/Remove. 

5. The deinstallation of O&O UnErase will be initialized. 

6. A dialog box will appear in which you will be given the choice 
to Change, Repair, or Remove the program.. 

7. Select Remove and click on Next (the option to Repair a 
program is not available in the older version of MSI). 

8. The older version will be removed. It is, however, possible to 
keep the old settings from the previous version and use them for 
the new version. 

9. After the deinstallation is complete it will now be possible to 
install the new release. To do so, just follow the directions that 
are described above regarding the normal installation of O&O 
UnErase V2.0. 

Entering License Code 

Note: In order to unlock the full version of O&O UnErase after 
installation or at a later time, it is necessary that you have a valid license 
code. If no license code has been entered, O&O UnErase will operate 
only as a test version. If you have questions, please contact our support 
department. 

After installation has been completed, the O&O Registration will be 
started, making the registration of O&O UnErase simple and efficient. 
To register O&O UnErase you will need to use the registration code you 
received when you purchased your product.  

This registration code is also referred to as the license key, license code, 
serial number, or product ID. It may consist of either just a serial number 
or a combination of the names and serial numbers. Please note the 
directions that accompanied your license code. 

The registration code can be entered during installation or later at your 
convenience. To do so, simply open the unregistered version of O&O 
UnErase and the Registration Assistant will appear. 
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Unregistered Test Version 

The Registration Assistant will appear every time the unregistered 
version of O&O UnErase is opened. It will also appear when the 
registration code has been incorrectly entered. Should this occur, please 
double-check you registration code and try again. 

The first step is to select whether you would like to enter your purchased 
registration code, continue to use the unregistered test version of O&O 
UnErase, or purchase your own license. When you have made your 
decision, please press the Next button to continue. 

Select Enter registrations code to proceed to step 2 of the registration 
assistant. 

If you decide to continue testing the product, the program will start. If 
you click on Buy now, you will be forwarded to our homepage where 
you can find information about the purchase of our products. 

The registration of O&O UnErase may be aborted at any time. To do so, 
simply click on the Cancel button and confirm your decision. 
 

 

Figure 1 Registration Assistant 

Registration Dialog 

In the registration dialog you can enter your registration code that you 
received when you purchased O&O UnErase.  

Please enter your name, your company's name, and then your serial 
number. Please note that this number must match the number you 
received through the purchase of the product. In addition, make sure that 
your do not confuse the letter "O " with zeros or enter in any empty 
spaces. 

Then click on Next to save the registration data or Cancel to close the 
dialog box without saving any registration information. 
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Figure 2 Registration Dialog 

If you run into any problems during registration, please contact our 
support department. 

Completing Registration 

If the license code was correctly entered, a dialog box will appear 
confirming this. It will now be possible to immediately register online 
and take advantage of the services O&O has to offer. This includes 
technical support and discounted software updates. 

To do so, click on Register product online, to close the Registration 
Assistant, click on Close. 

Removing O&O UnErase 
To remove O&O UnErase from your System, open the Control Panel 
under the heading Settings in the Start Menu and click on Software.  

Please select O&O UnErase V2.0 from the list of installed software and 
click on the Add/Remove... button.  

Confirm the deinstallation of O&O UnErase V2.0. After this process is 
completed, a dialog box will appear confirming this. O&O UnErase is 
now removed from your system. 
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Using O&O UnErase 

Starting O&O UnErase 
As part of the installation process, a program group will be created in the 
Start Menu for O&O UnErase. This program group may be visible to all 
users or only the current user, depending on which option was selected 
during O&O UnErase's installation. When it is visible, it may be found 
under the heading O&O Software. 

In this program group you can find the program O&O UnErase as well 
as a link to the online product documentation. 

The online product documentation is your central source of information 
for all matters regarding the operation of O&O UnErase. As described 
above, this can be accessed through the O&O UnErase program group. 
Alternatively, this documentation can be accessed through the Help 
menu or by pressing F1 on your keyboard whenever the product is 
running. 

Main View 
The Main View in O&O UnErase behaves very similar to Windows 
Explorer, enabling you to easily use the program with only little or no 
previous knowledge. 

The Main View is divided into three vertically tiled panes: 

• Frequently used commands and settings are accessible 
through the pane on the left. These commands are also 
accessible through the Toolbar or the Context Menu. 

• The List of drives and directories in the middle pane enables 
an easy navigation through existing and already-deleted files 
very similar to Windows Explorer. 

• The List of Folders and Files on the right-hand side gives you 
all pertinent file information regarding the selected existing and 
deleted files. 
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Figure 3 Main View of O&O UnErase V2.0 

Status Bar 

At the very bottom of the Main View the Status Bar can be found in 
which the progress of all running searches and other status reports are 
displayed. 

Toolbar 

The Toolbar is the fastest way to access the most important functions of 
O&O UnErase. All commands, however, can be accessed through the 
pull-down menus at the top of the Main View. Through the View menu 
you can customize the composition of the Toolbar to meet your needs. 
 

 

Figure 4 All Toolbars Including the Quick Search Bar 

Displayed from left to right: 

• Search for a drive on the system. 

• Open the Advanced Search dialog. 

• Restore deleted files. 

• Cancel current search. 

• Go up one level. 

• View Help. 

• View program information. 

• Switch views. 

o Tiles 

o Icons 

o List 
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o Details 

o Toggle task list. 

o Displays only deleted files and folders. 

o Toggle Filter function. 

Quick Search 

The Quick Search Bar below the Toolbar enables the simple and 
immediate search of folders on a particular drive by allowing you to 
enter a specific directory path. It is also possible here to use place 
holders such as '*'. 
 

 

Figure 5 Quick Search Bar 

Filter 

If you would like to limit the files displayed in the file list on the right-
hand side, it is possible to use the Filter function. This feature may be 
activated through the View menu or by pressing the Filter icon in the 
Toolbar. When activated, a series of fields will appear in which specific 
text may be entered to narrow down the number of files displayed. As 
before, it is possible here to use place holders. 
 

 

Figure 6 File List with Activated Filter Function 

Tip: In general, it is easier and faster to just use the Advanced Search 
function to find and display a specific set of files. 

Searching for Deleted Files and Folders 
To find deleted files and folders on a drive, please follow the directions 
below: 

1. Select from the list of drives on the system the drive which you 
would like to search. 

2. From the File menu at the top of the screen select the command 
Search for deleted files. 
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3. The search will now be initialized. You can follow the progress 
of the running search in the Status Bar at the bottom of the 
screen. 

4. After he search is completed, the files and folders found during 
the search will be marked in both the list of drives and files with 
a red "X" or arrow. 

 

Figure 7 Main View with Deleted Files and Folders 

Tip: You can also execute a Quick Search by way of the Search field in 
the Toolbar. Just enter the drive letter and the path of the directory you 
would like to search and press Enter on your keyboard. 

Canceling a Search 
If you would like to cancel a Search, select Cancel search from the File 
menu or press the corresponding icon in the Toolbar. The search will 
then be canceled and the files and folders that have already been found 
will be displayed. 
 

 

Figure 8 'Cancel Search' Icon in the Toolbar during a Search 

Tip: Alternatively you can use the keyboard shortcut Ctrl+Esc to 
interrupt a running search. 

Deleted Files and Folder Designations 
The red "X" indicates a file or folder is deleted. A small "X" displayed 
with a folder indicates that deleted files have been found in this folder, 
although the folder itself is still intact. 

Icon Definition 
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The folder has been completed deleted (large red "X") 

 
The folder contains deleted files or folders (small red "X") 

 

This file has been deleted and can probably be restored (red arrow). 

Normally the original filenames of the deleted files can be restored. 
However, if this is not possible, the folders and files will be generically 
numbered and named by O&O UnErase. 

Restoring Files and Folders 
The next step after deleted files or folders have been found is to restore 
the ones you need (if this is possible). 

1. Files and/or folders you wish to restore can be selected in either 
the middle or right-hand panes of the Main View. 

Tipp: Please note that in the middle pane of the Main View only one 
single folder may be selected for restoration. In the right-hand pane it is 
possible to select more than one file for restoration by pressing the Ctrl 
key on the keyboard while selecting multiple files. To select all files in a 
specific older, use the keyboard shortcut Ctrl+A.  

2. Press the Restore icon on the Toolbar or select the 
corresponding heading in the Context Menu.  

3. It is now possible to select where the restored files are to be 
saved. As your target directory, you may create a new folder or 
select one that already exists. 

4. In order to avoid any possibility of data loss, it is advised that 
you save the newly restored files onto a different partition than 
the one where the files were originally stored. Please be aware 
that it is possible to store the files onto a network drive as well. 

Tip: It is also possible to simply drag-and-drop deleted files and folders 
you would like to restore into a directory displayed in the Main View. 
The restoration of the deleted files will automatically follow. 
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Figure 9 Selection of Target Directory 

Advanced Searches 

With the O&O UnErase's Advanced Search function, you posses a 
powerful tool for quickly and securely finding deleted files. Through a 
series user-defined search parameters it is possible to considerably 
increase the precision of your search result. 

 

Figure 10 Advanced Search Dialog  
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Search Settings 

The search settings dialog enables you to define the drive or folder to be 
searched. If you would like to also search subfolders, select the option 
with the same name. 

It is also a possibility to expand the search to include files that have not 
been deleted. To do so, please uncheck the option Only search for 
deleted files. If this option remains selected, only deleted files will 
appear in the search results. 

Filename 

In the field called Filename, you can either enter an exact filename or a 
filename containing a placeholder. For example, "*.BMP" would 
indicate you only wanted to search for Bitmap images.  

Letter capitalizations are not considered in by the search function. You 
can use the special characters "*" and "?". "*", however, can be used for 
multiple characters, whereas "?" may only stand for a single character. 

 

Filename Definition 

* All filenames 

*.* All filenames containing a "." 
e.g. a.txt, abc.doc, xyz.exe 

A* All filenames that begin with "a" or "A" 

*a All filenames ending with an "a" or "A" 

*a* All filenames containing an "a" 
e.g. abc.txt, cba.txt 

*.txt All filenames with ".txt" on the end 

?.txt All filenames consisting of a single character and ".txt"  
e.g.  a.txt, 9.txt 

A?c.txt All filenames that containing an "a", followed by a single character, 
and ended with "c.txt"  

Contained Text 

An especially powerful option is searching for text contained in the file. 
If you are looking for a file but only can remember a fragment of its 
name or contents, then this could be very useful to you. 

Using the Filter When Searching 

In order to customize your search further, it is possible to use the Filter 
function. 

File Size 

Here you can limit the size of the files that are to be searched. Just enter 
a range in Kbytes in which the desired file might fit. 

Date 

This option allows you to enter a range of dates pertaining to the file and 
defining how that date range is to be applied during the search: 
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• Created – Date when the file was first created 

• Modified – Date when the file was last saved 

• Accessed – Date when the file was last accessed 

File Attributes 

The search can also be narrowed down to looks for specific attributes of 
the desired file. You can select from three options regarding each 
specific attribute: 

• Marked (Checked) – The file must exhibit this attribute. 

• Unmarked (Empty) – The file may not exhibit this attribute. 

• Marked Green – This attribute will not be considered as a 
search parameter. 

Running an Advanced Search 

To Run an Advanced Search you have three options: 

• New Search – A search will be initialized and all previous 
search results will be lost. 

• Add – The search will be initialized and the search results will 
be added to the search results already displayed. 

• Remove – The search will be initialized and those search results 
found will be filtered out of the list of search results already 
displayed. 

You may repeat the search function as many times as you like, adding or 
removing the results from the displayed list of search results as you go. 
While the search is running, the search dialog box will remain closed. 

When you not long would like to run a search, you can close the search 
dialog by pressing the Close button. 
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Starting O&O UnErase Without 
Installing it 

O&O InstantUnErase 
If you would like to restore deleted files, it is imperative that you do not 
write any more data to disk. This is because only those files, whose data 
have not already been overwritten by other data, can be restored. For this 
reason it is very important that O&O UnErase be already installed before 
a crisis occurs. The installation of the software after a data loss occurs 
could lead to the overwriting of die data you are trying to restore. 

However, if a crisis occurs and O&O UnErase is not yet installed, there 
is another option. With the feature O&O InstantUnErase you have the 
possibility of running O&O UnErase without installation by creating a 
O&O InstantUnErase emergency disk on a parallel system.  

License to Use O&O InstantUnErase 
In purchasing the license for O&O UnErase, you also purchased a 
license to for O&O InstantUnErase. O&O InstantUnErase is basically an 
"Emergency" version of O&O UnErase that can be used on both the 
computer where O&O UnErase is installed as well as an additional 
computer where the software is not installed.  

Because a single license may only be used on one computer, you will be 
required to do the following: 

1. Install O&O UnErase on any computer. Do not enter the license 
code to unlock the full version of the software. Instead, use the 
test version. 

2. Start the O&O InstantUnErase Assistant from the Start Menu. 
Follow the on-screen directions to create an emergency disk. 

3. Open O&O UnErase from the emergency disk on the computer 
on which you would like to restore one or more deleted file(s).  

4. Enter the license code for O&O UnErase. This license now 
exclusively belongs to this computer! 
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One the data restoration has completed, you now can install the full 
version of O&O UnErase onto this computer. Please note that such a use 
of this software is not allowed and is against the license agreement. If 
you would like to use O&O UnErase on multiple computers, it is 
possible to purchase a multi-user license. Our sales team would be more 
than happy to assist with this free of charge and obligation. 

Creating an Emergeny Disk 
To create an O&O InstantUnErase-Diskette, go to corresponding 
heading in the Start Menu open the O&O InstantUnErase Assistant. 
Then, follow the on-screen directions of the Assistant. 

 

Figure 11 O&O InstantUnErase Assistant 

Next, you will be required to select where you would like to save this 
file. This can be a folder or drive (locally stored on your computer or on 
the network). Click the button Browse to select a location. 
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Figure 12 Selection of Target Drive or Folder 

Now select the file source. Here you have the possibility of selecting the 
O&O UnErase's installation folder or the actual installation file itself 
O&O Unerase.msi. 

 

Figure 13 Selection of File Source 

Double-check your selections; insert blank media into the corresponding 
drive; and the initialize the coping process. As soon as all files have been 
copied, you can start using O&O InstantUnErase. 
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Figure 14 Copying Files to Removable Media 

Tip: The target folder can be a network drive or a USB stick as long as 
the computer on which you would like to use O&O InstantUnErase can 
access that data. 

Starting and Using O&O InstantUnErase 
Insert the created removable media into the drive of the computer on 
which you would like to run O&O InstandUnErase (or open the folder 
where the Assistant stored the O&O InstantUnErase data). Inside you 
will find the file OOUE.EXE. Double-click this application to run it. An 
O&O UnErase registration dialog will appear. Enter your registration 
information and continue. 

Please note that the license will not be saved onto this computer. This 
could overwrite important data, potentially preventing their restoration. 
Because of this, the license will have to be reentered with every new 
start of the program. 

After a successful registration the Main View of O&O UnErase will 
appear. It will now be possible to use all of the features O&O UnErase 
has to offer. More information regarding this can be found in the section 
entitled "Using O&O UnErase". 
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Support and Contact 

Technical Support 
To receive more information about O&O UnErase, please visit our 
website, http://www.oo-software.com, and get the latest information 
about product developments and support. Also included on our website 
are regularly updated FAQs and Knowledge Bases that offer the most 
common problems and questions regarding our products. 

All registered customers receive installation and product support free of 
charge for the first 90 days after registration. When contacting our 
support department, please do not forget to have your registration code 
ready.  

In addition, it may be helpful to read our frequently asked questions 
(FAQ) section of our website before you contact our support department. 
It is always possible that your specific question or problem may have 
already been addressed. 

Authorized Distributors 
For answers to all questions regarding the licensing and purchase of our 
software products, our authorized distribution partners in over 30 
countries stand ready to assist you. Their names and addresses may be 
found at our website under the Purchase heading. We would also be 
more than happy to assist you in finding the partner closest to you. 

O&O Software GmbH 

Internet: http://www.oo-software.com/ 
Support: support@oo-software.com 
Sales: sales@oo-software.com

Am Borsigturm 48 
13507 Berlin 
Germany 
Tel.: +49-(0)30-430343-00 
Fax: +49-(0)30-430343-99 
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End-User License Agreement (EULA) 

O&O UnErase V2.0 
IMPORTANT – PLEASE READ CAREFULLY  

This end user license agreement is a legally binding contract between 
yourself (as a natural or a legal person) and the company O&O Software 
GmbH (O&O) for the software product named above. By installing the 
software product, you declare your agreement with all conditions of the 
license agreement. 

If you do not agree with the conditions of the license agreement, you are 
not entitled to install or use the software product. Should this be the 
case, you can return the software product along with a copy of the 
invoice or receipt to the distributor from whom the product was 
purchased in exchange for a full refund.  

The software product is protected by copyright laws and international 
copyright contracts as well as other laws and agreements concerning 
intellectual property.  

1. Subject of the contract 

The subject of this contract is the computer program, the description 
thereof and the user manual as well as any other accompanying written 
material. This will henceforth also be referred to as “software”.  

O&O wishes to point out that, at the current state of technology, it is not 
possible to create software that works perfectly in all applications and 
combinations. The subject of this contract is therefore a software 
program that is fit for the purposes detailed in the description and the 
user manual.  

2. License granting  

For the duration of this contract, O&O grants you the simple, non-
exclusive and personal right (henceforth referred to as “license”) to use a 
copy of the software on a single computer. If this single computer has 
multiple users, this user right applies to all users of the system. 

As a license-holder, you may physically transfer the software (i.e. saved 
on a data carrying medium), on condition that it not be used on more 
than one computer at a time. Further use, especially repeated installation, 
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use, and subsequent uninstallation on various computers (floating 
license) is prohibited.  

Test license 

You are entitled to test the software free of charge and without 
obligation according to the terms stated within the software (30 day trial 
period or unlimited read-only trial). If you wish to continue using the 
software, you must purchase the relevant license.  

3. Description of further rights and limits  

The license-holder is prohibited from; 

(a) altering, translating, reverse-developing, decompiling or 
disassembling the software without the advance written 
permission of O&O  

(b) creating products derived from the software or making copies of 
the written material, translating or altering the written material 
or creating products derived from the written material 

(c) distributing copies of the software to third parties 

(d) changing or removing the copyright mark on the copies of the 
software  

(e) renting out, - or lending the software  

The license holder is permitted to transfer all rights from this license 
agreement permanently to another person, provided that the recipient 
also agrees to all conditions of this license.  

The license holder must use the software only in compliance with all 
relevant laws.  

4. Ownership of rights 

Any ownership rights applying to the software, including but not limited 
to copyright laws, belong to O&O. Any not explicitly claimed rights are 
reserved by O&O. 

The purchase of a license for a product simply grants a right to use the 
software as described in the conditions of the license agreement. This 
does not imply a right to the software itself. In particular, O&O reserves 
all publication, multiplication, processing and utilization rights to the 
software.  

5. Reproduction 

The software and accompanying written material are protected by 
copyright laws. The user has the right to create copies of the software for 
back-up and archiving purposes. He or she is thereby also obliged to 
reproduce O&O’s copyright mark on the physical medium or in the 
program. A copyright mark present in the software may not be removed. 
Copying or reproducing the software in original or altered form, or 
merged with or included in other software, is explicitly forbidden.  

Provided you pass on only the test version, you may reproduce the 
installation data as often as you wish. However, you may only pass on 
exact copies and may not alter these in any way.  
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For such reproduction, you may not demand any kind of compensation. 
You may not distribute or market this product in combination with other 
products - whether commercially or non-commercially - without the 
advance written permission of O&O. 

6. Length of the agreement 

This agreement is valid indefinitely. The right of a license-holder to use 
this software is removed automatically and without notice if he or she 
violates one of the terms of this agreement. At the end of the period of 
right to use, the license-holder is obliged to destroy the software, all 
copies of the software, and the written material.  

7. Compensation for breach of contract 

O&O would like to point out that you are responsible for any damages 
arising from breach of copyright if you violate these contract terms. 

8. Changes and Updates 

O&O is entitled to update the software as it wishes. O&O is not obliged 
to make updated versions available to license holders who have not 
registered their product with O&O, or who have not paid the update fee. 
Any additional software code that is made available to you as an update 
is considered a part of the software and is therefore subject to the terms 
of this agreement.  

9. O&O’s Guarantees and Responsibility  

(a) O&O guarantees the original license-holder that the data 
medium carrying the software is free of errors at the point of 
delivery, assuming normal operating conditions and a normal 
level of maintenance.  

(b) If the delivered data carrier is faulty, the purchaser can demand 
a replacement during the 24-month guarantee period. For this, 
he or she must return the data carrier, any back-up copies and 
the written material along with a copy of the invoice or receipt 
to O&O or to the dealer where the product was purchased. 

(c) If a fault as described in clause 9 b is not corrected by means of 
a replacement delivery within a reasonable time period, the 
purchaser can demand either that the sale price be reduced or 
that the contract be cancelled. 

(d) For these reasons and for those mentioned in clause 1 of this 
contract, O&O accepts no responsibility for mistakes in the 
software. In particular, O&O does not guarantee that the 
software will meet the particular requirements and demands of 
the purchaser or that it will function together with other 
software he or she has chosen. The purchaser is responsible for 
the correct choice of software and the consequences of the use 
of that software, as well as the results aimed at or intended. The 
same principle applies to the written material that accompanies 
the software. If the software is fundamentally unfit for use as 
described in clause 1, the customer has the right to cancel the 
contract. O&O has the same right should the creation of 
software that is fundamentally fit for use as described in clause 
1 not be practically possible.  
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(e) O&O is not responsible for any damages, unless such damages 
are caused deliberately or arise from gross negligence on the 
part of O&O. In contracts with traders, an assumption of 
responsibility for gross negligence is excluded. This does not 
apply to assurances by O&O that refer to specific 
characteristics. Responsibility for damages not included in such 
an assurance will not be accepted.  

10. Competency 

If the license-holder is a registered merchant under German law, the law 
that applies to this contract is the law of the Federal Republic of 
Germany. In this case, the state and federal courts of the Federal 
Republic of Germany assume responsibility.  

If you have any questions regarding the licensing of O&O software or 
you wish to contact O&O, please get in touch with us as follows: 

O&O Software GmbH 

Am Borsigturm 48, 13507 Berlin, Germany 

International: Tel. +49-30-4303 4303 / Fax +49-30-4303 4399 
Germany: Tel. (030) 4303 4303 / Fax (030) 4303 4399 

E-mail: info@oo-software.com 
Internet: http://www.oo-software.com  
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